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Preface

Audience
This guide is intended for new users and administrators of the Action Request
System (AR System). It provides online demonstrations showing the AR
System in two sample help desk environments — Windows and UNIX. It also
provides information about the sample schemas provided with the AR System.

This guide assumes that you are familiar with the operating environment of
the platform on which you are running the AR System client tools. If you are
installing the AR System NT server software, you should be familiar with the
Windows NT environment.

Overview of this Document
Chapter 1, If You Are New to the AR System, provides information to allow
you to get started with the AR System. It also provides an overview of the
quick installation for first-time users. Finally, it provides a table of common
topics to enable you to quickly find the specific information you need in the
documentation. If this is the first time you have installed or used the AR
System, we recommend that you read this chapter before you proceed to other
chapters in this guide or the Action Request System Installation Guide.

Chapter 2, Help Desk Demonstration for Windows and
Chapter 3, Help Desk Demonstration for UNIX, feature live use of the AR
System Server and Tools. They will help you to familiarize yourself with the
operation of the AR System on your platform. You follow a detailed script to
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track a problem from initial submission to closure, learning about the design
and functionality of the AR System along the way. Additionally, you will learn
how to use the Administrator Tool to customize applications.

Chapter 4, Help Desk Demonstration and Sample Schemas, introduces the
AR System objects that comprise the demonstration environment. In addition,
an overview of the sample schemas that are shipped with the AR System is
provided.

AR System Documents
The Action Request System Getting Started Guide and Sample
Schemas provides an online demonstration showing the use of the AR System
in a sample help desk environment and describes how you can use the sample
schemas provided with the AR System.

The Action Request System Installation Guide describes how to install and
license the AR System software. There are separate Installation Guides for
UNIX and Windows NT environments.

The Action Request System User’s Guide is a how-to description of the
operations performed by all users of the AR System. There are separate User’s
Guides for environments supporting the Motif, Macintosh, and Windows
graphical user interfaces (GUIs) and for ASCII terminals.

The Action Request System Administrator’s Guide describes how the AR
System administrator can use the Administrator and Import Tools to set up the
AR System and define its local operations. This manual is also a reference for
advanced AR System concepts. There are separate Administrator’s Guides for
the UNIX and Windows environments.

The Action Request System Programmer’s Guide is a reference guide for
programming with the application programming interfaces (APIs) that come
with the AR System.

The Action Request System Troubleshooting and Error Messages Guide
provides information to help you identify and solve problems with the AR
System.

The Action Request System Distributed Server Option Administrator’s Guide
provides information about operating the AR System in a distributed, multi-
server environment.
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The ARWeb Administrator’s Guide provides details about installing, using,
and customizing the ARWeb application so that you can provide access to your
company’s AR System applications through the World-Wide Web.

The Action Request System Help Desk Template Guide describes the help desk
application that runs in conjunction with the AR System to help you manage
your internal help desk organization.

Conventions Used in this Manual
bold font

Indicates that a word is a new or important term.
Example: filters.

Initial Caps
Button and menu names and items have the first letter capitalized.
Example: File.

computer font
Indicates computer output, including UNIX prompts, an explicit directory, or a
file name.
Example: prompt% .

Indicates data to be entered by the user.
Example: aruser & .

<italic  font in angle brackets>
Indicates a variable directory, file name, or string that you replace with an
appropriate directory, file name, or string.
Example: <ar_config_dir>.

italics
Indicates a reference to another manual or to a different section within the
current manual.
Example: see AR System Documents.
Italic type is also used for emphasis.
Example: All users will be affected.
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1

If You Are New to the AR System 1

This chapter provides the following information:

• Overview of the AR System and the Getting Started Guide

• A quick tour of the AR System

• Common tasks

Overview
This section provides an overview of both the Action Request System
(AR System) and the Getting Started Guide and Sample Schemas manual.

The Action Request System

The AR System is an adaptable client-server application that works with your
database to track and organize both data and processes. The system
administrator creates schemas which automate much of the workflow, and
make data entry, retrieval, and tracking quick and efficient.

Adaptability

As an AR System administrator, you may customize the AR System to suit
your particular needs. You set the criteria for the workflow engine. For
example, you may decide that workflow should be designed around the skills
of your personnel or the nature of the issues, among other criteria.
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As an AR System administrator, you may choose to control AR System
processes based on events (filters) and on time (escalations). For instance, you
could have the AR System automatically send a message to a technician
whenever the technician has been assigned an issue (filter), and if the
technician does not respond within a set period of time, have the AR System
re-route the issue to an available technician (escalation).

Both AR System administrators and end users may customize their views of
particular schemas. This allows personnel with diverse tasks to organize their
data in the most suitable manner.

Components

The sections below describe some of the more frequently used terms and
concepts of the AR System.

Schemas
The information fields in the AR System databases are described in schemas.
Each schema represents a view of a database on the AR System server. The
AR System comes with several sample schemas in addition to the
demonstration schemas, and the administrator can build additional schemas as
needed.

When the AR System administrator defines a schema, the administrator sets up
the fields on the schema and determines what kind of information users will
enter in each field. The administrator may also create menus and help text to
help users submit tickets. The demonstration schemas are described in
Chapter 4, Help Desk Demonstration and Sample Schemas.

The demonstration uses schemas to implement the following features:

• Record information about a problem needing attention from the Help Desk
staff

• Research the problem, log work completed, and notify the end user of the
solution

Menus
The AR System administrator can define character menus that can be attached
to any character field on any schema on the server. Menus attached to
character fields are used to allow users to select a value from a set of values.
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As an end user, you will use menus in the demonstration to search for a
resolution to the current problem. As a backline staff member, you will add
data to an existing menu, providing end users with a more complete self-help
tool.

The demonstration uses menus to implement the following features:

• Categorize problems on a multi-tiered basis

• Assign calls to available and appropriate technicians

Filters
A filter is a mechanism that executes on the server, and causes a specific set of
actions to be performed when a specific set of qualifying conditions are met. In
addition, filters help define the work rules for AR System users at your site.

The demonstration uses filters to implement the following features:

• Notify support technicians of call assignment

• Notify personnel of call escalations, or requests for call reassignment

• Notify callers when a problem is resolved

• Check work rules, such as parsing fields for valid data entry

Active Links
Active links define operations that are executed on the client machine when
the user performs a specific action.

The demonstration uses active links to implement the following features:

• Retrieve caller information

• Retrieve similar calls

Escalations
Escalations test for items matching a set of conditions at a set time or interval
and, if the conditions are met, one or more actions are taken. For example, you
might create an escalation that executes when a ticket more than eight hours
old has not yet been closed by support personnel.

In the demonstration, no escalations are used.
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The Guide

This document includes Help Desk demonstrations for Windows and UNIX
systems. These demonstrations will take you through a step-by-step process, as
an end user, frontline staff member, and backline technician use the AR System
to resolve an open issue.

A Quick Tour of the AR System
You can follow the steps below to set up and become familiar with the Action
Request System.

1. Install your AR System Server and clients using the instructions provided
for your platform in the Action Request System Installation Guide.
If you wish, you can perform a quick installation, which allows you to use
and evaluate the AR System without performing a complete installation.
Instructions for this quick installation are provided in Chapter 1 of the
Action Request System Installation Guide for your platform. This quick
installation allows you to run the AR System without a license. However,
you are limited to a maximum of approximately 50 records for each schema.

2. You may see an example of a basic AR System application by running the
Help Desk demonstration explained in this document. This
demonstration follows the activities of three members of a Help Desk as
they use the AR System.
When you have finished viewing the Help Desk demonstration, you may
wish to rename the sample users and continue by establishing the setup of
your own AR System. Renaming the sample users allows you to use the
fixed licenses the sample users need in the Help Desk demonstration. Be
sure to rename and provide a password for the Demo user, as this user has
administrator access to the system.

3. You may see a sample of a more sophisticated AR System application by
installing and reviewing the AR System Help Desk Template, which is
packaged apart from the AR System. See the Help Desk Templates Guide
for Users and Administrators for the information needed to install and use
the template.

4. If you are ready to activate your AR System licenses, follow the
instructions provided in the Action Request System Installation Guide.
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5. When you are ready to customize the AR System to meet your particular
application needs, you can activate users and groups of users, define your
workflow, and adapt or define schemas in any way. Common Tasks on
page -6 will aid you in finding the information you need to perform these
tasks.
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Common Tasks

Table 1-1 Common Tasks (1 of 2)

For Information About Refer To

Running an AR System demonstration Getting Started Guide and Sample Schemas
Chapters 2 and 3

Licensing Action Request System Installation Guide
Chapter 8

Available sample schemas Getting Started Guide and Sample Schemas
Chapter 4

Running the AR System User and
Notification Tool

Action Request System User’s Guide

Solving problems Action Request System Troubleshooting
and Error Messages Guide

New features or known problems Action Request System Release Notes

Running the AR System Administrator
Tool

Action Request System Administrator’s
Guide Chapters 1, 2, and 3

Using the AR System Import Tool Action Request System Administrator’s
Guide Chapter 14

Setting up groups and users Action Request System Administrator’s
Guide
Chapter 5

Designing your AR System
implementation

Action Request System Administrator’s
Guide Chapter 4

Submitting an action request Action Request System User’s Guide
Chapter 3

Modifying or printing an action request Action Request System User’s Guide
Chapters 4 and 5

Defining schemas, fields, menus, filters,
escalations, and active links

Action Request System Administrator’s
Guide Chapters 6, 7, 8, 9, 10, 11, and 12

Databases and database considerations Action Request System Installation Guide

Setting up email support Action Request System Installation Guide
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Using email in the AR System Action Request System Administrator’s
Guide Chapter 15 and Action Request
System User’s Guide Chapter 9

Using the application programming
interface (API)

Action Request System Programmer’s
Guide

Using the Help Desk Template Action Request System Help Desk
Template Guide

Table 1-1 Common Tasks (2 of 2)

For Information About Refer To
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9

Help Desk Demonstration for
Windows 2

Once you have installed the AR System server and client tools, you are ready
to experiment with the software. Your AR System package comes with two
demonstrations to help you learn about the benefits, features, and functionality
of Remedy’s Action Request System, the leading help desk solution. The first
demonstration is the self-running Action Request System Demo Disk. Use the
demonstration diskette on any Windows PC or UNIX station to learn about the
key benefits and uses of the AR System. Install and run the demo according to
the instructions on the disk label.

The second demonstration is the Help Desk Demonstration, which is described
in this chapter. It features live use of the AR System Server and Tools and is a
great way to familiarize yourself with the operation of the AR System. You will
follow a detailed script to track a problem from initial submission to closure,
learning about the design and functionality of the AR System along the way.
Additionally, you will learn how to use the Administrator Tool to customize
applications. The complete demonstration consists of five sections and, if you
are a first time user, takes about 45 minutes to complete.

By working through the demonstration, you will:

• See how a team works together and, with the aid of predefined, site-specific
workflow rules, quickly resolves user requests for assistance.

• Learn the basics of how to use the AR System User, Notification and
Administrator Tools.

• See ways to use the AR System to automate your business workflow.
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Introducing Joe, Francie, and Bob
This scenario introduces you to three people — Joe User, Francie Frontline, and
Bob Backline. Joe, Francie and Bob represent three types of users who can take
advantage of the AR System in a typical help desk environment.

During the course of this Help Desk demonstration, you will at some point
assume the role of each user. Let’s meet them now:

Joe User: Joe is an AR System end user. Running the AR
System is not Joe’s main job. In fact, Joe needs to run the
AR System User Tool only when he has a problem with
the hardware or software that he does use regularly. Joe
can also run the AR System Notification Tool to ensure
that he is notified when any problem he submits is fixed.
Joe is experiencing problems connecting to Remedy
Corporation’s Home Page on the World Wide Web
(WWW). He will submit a help desk ticket to get the
problem resolved.

Francie Frontline: Francie is a first line support staff
member. She typically submits calls and acts as a
generalist for problem resolution at the company’s
internal help desk. In this role, she attempts to resolve
each issue, and, if she is unable to do so, assigns
incoming requests for help to the appropriate help desk
staff member. She then follows up to make sure all
problems are resolved in a reasonable period of time.
Bob Backline: Bob usually gets calls assigned to him
from other support staff members. As a back line staff
member, Bob is a specialist with a more narrow area of
expertise than the front line staff. He resolves the call and
updates information in the ticket.
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Now it’s time to start the Help Desk demonstration and have some fun. You
will follow a single problem through a simple problem resolution process. In
some cases, an Administrator’s Note outlines the workflow process used to
create the actions you see happening in the demonstration.

The demonstration script will guide you through the keystrokes you need to
make to complete each step.

Note – In a real work environment, each of these users would be running their
AR System tools on separate machines. In this demonstration, you will
simulate the use of three separate machines by logging in to your AR System
tools alternately as three different users.

1. Submit new problem.

2. Analyze and
possibly reassign
problem.

3. Fix problem.
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An Internal User Submits a Ticket
The Computing Services Group recently installed two new pieces of software
on Joe User’s computer: the Remedy Action Request System User Tool and
Web Wanderer, a WWW browser. Joe is very interested in accessing
information from the WWW and attempts to locate the Remedy Corporation
home page at http://www.remedy.com .

While the Web browser itself seems to function properly, Joe’s browser
displays an error message when he tries to access the Remedy home page.
Anxious to get beyond the error, Joe proceeds to use his other new software
tool, the AR System User Tool, to initiate a service request with his internal
help desk. The help desk trainer has told Joe that the AR System User Tool is
like dialing 911, with calls going directly to the help desk. Joe decides to make
his call to the help desk using the new tool.

Log In to the DemoHelpDesk Schema

In this section, you will log in to the User Tool as Joe User, and select the
DemoHelpDesk schema. A schema is a form that represents a set of related
data in the AR System database. The DemoHelpDesk schema is designed to be
used for service requests.

To log in and select the DemoHelpDesk schema:
1. Open the AR System User Tool by double-clicking the AR User icon in

the Remedy AR System program group.

Figure 2-1 Remedy AR System Program Group

2. Choose Login from the File menu. The Login dialog box appears.
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Figure 2-2 Login Dialog Box

3. Type Joe User  in the User Name field. Remember, capitalization and
spaces count. Leave the Password field empty. Click the OK button.

4. Choose Open Submit from the File menu. The Select Schema - Submit
dialog box appears, as shown in Figure 2-3. This dialog box lists the
schemas a user can submit.

Figure 2-3 Select Schema - Submit Dialog Box
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5. Select the DemoHelpDesk schema and click the OK button. a
DemoHelpDesk schema submit window appears, and should look similar
to Figure 2-4:

Figure 2-4 End User View of the DemoHelpDesk Schema

You have successfully logged in to the AR System as Joe User, and selected the
schema used for entering problems. Next, you will fill in the information
regarding the problem Joe is having.

Provide Information About the Request

Joe needs to provide information to the help desk staff about the problem he is
encountering. Typically, a user such as Joe provides the help desk with details
about himself, as well as the problem.
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To fill the DemoHelpDesk ticket with pertinent information:
1. In the Employee Id field, type 3000 and press Enter.

Since Joe User has contacted the help desk in the past, his caller record
exists and information about him is on file. When you press Enter, notice
Joe’s first and last name are automatically filled in.

Figure 2-5 DemoHelpDesk Schema with Auto-Filled Data

Note – The auto-fill capability demonstrated here is achieved by an active link.
The active link takes the employee number as query criteria, queries the
DemoHD:CallerDetail schema for a match, and returns the data.

2. Locate the Problem Type field. Click the character menu icon  and
select Software from the menu.

3. Locate the Item Affected field. Click the character menu icon to the right
of the field, then choose Web Browser.
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Figure 2-6 Query Menu on the DemoHelpDesk Schema

Notice that all selections in the Item Affected field menu are related to
software. This information is taken from the previous selection made in the
Problem Type field.

Note – The values of the Item Affected fields are provided by a query style
menu, which takes the criteria to match from the Problem Type field. It then
queries the DemoHD:ItemAffected schema to find all entries related to a
Problem Type definition of Software.

End User Searches for the Solution

Joe has the ability to check the solutions database to see if a similar problem
was reported in the past, and what the resolution might be.

To search the Solutions database from the DemoHelpDesk schema:
1. In the Possible Solutions field, click the character menu icon.
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Figure 2-7 Possible Solutions Displayed on DemoHelpDesk

The AR System shows all known solutions matching the contents of the
Problem Type and Item Affected fields. Joe reviews these solutions, and
realizes none apply to the problem he is encountering.

Note – The ability to search the possible solutions database is achieved with a
query style menu. This menu queries the DemoHD:Solutions schema for all
entries with matching values for the Problem Type and Item Affected fields.

2. Since none of the possible solutions are appropriate, click in the schema
window to dismiss the menu selections.

3. In the Problem Summary field, type: Cannot access Remedy home page .

4. Click the text editor icon  to the right of the Problem Detail field.

Click in the Problem Detail text editor that opens, then type: Using Web

Wanderer 2.1 for Windows. Error message: fatal error 500, can’t

access document.
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Figure 2-8 Problem Detail Text Field in the DemoHelpDesk Schema

5. Click the OK button to close the text editor.

6. In the Work Log, type in the following text:
Did not see a logical solution in Possible Solutions list.
Please analyze.

7. Click the Impact selection field. Choose Medium.

Submit the Request to the Help Desk Staff

Once Joe has finished filling in the necessary information and submitted the
ticket, the help desk staff will help him resolve his problem.

To submit the ticket to the database:
You have entered all data needed for problem submission. Now submit the
ticket.

The Call ID field will fill in automatically when you submit the ticket.
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1. Choose Apply from the Actions menu to submit the request. When you
submit the ticket, notice that a message is displayed on your screen, as
shown in Figure 2-9.
You can also use the Apply button  on the tool bar to submit your
ticket.

Figure 2-9 Notification of Assignment

Note – The message is achieved with a filter. This filter has two actions. The
first displays a message to the submitter, letting Joe know the ticket is assigned
to Francie. The second action notifies the assignee of the new ticket.

2. Click the OK button to dismiss the message.
In the lower portion of the window, you see the text:

Submit Successful-ID= xxxxxx

where xxxxxx  is a number representing Joe’s ticket ID. He can refer to this
ticket number when contacting the help desk regarding this request.

3. Click the Next Demo Step button to prepare the User Tool for the next
section.

4. Close the Submit window by double-clicking the control box in the
upper-left corner of the window.
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Section Conclusion

You have successfully submitted a call. So far, you’ve learned the
following:

• End user participation is encouraged with the AR System. End users
commonly submit their own requests, and even perform self help. Help
desk staff can focus their efforts on resolving requests, while end user
satisfaction is enhanced through participation.

• Some fields require data entry, while others can be automatically filled out
by the system. Menu selections simplify data entry even further.

• The AR System can route tickets automatically to the appropriate staff
members, and notify them using the Notification Tool. The Notification Tool
is explained in greater detail later in the demonstration

• End users have a simple view of the help desk application, making data
entry quick and easy. Users can be successful with minimal training.

Frontline Technician Works on the Submitted Call
Now that you have entered a new call as Joe User, you will assume the role of
Francie Frontline, a help desk technician, and bring the call to resolution. As
you saw in the previous section, Francie Frontline has been assigned Joe’s call.
This assignment was made by the system and was based on a defined business
rule: Assign all software problems to Francie Frontline. The Action Request
System allows you to simply define and change business rules for processing
any request. In this lesson, you will see how the help desk responds to the call.

Assume the Role of the Front Line Staff Member

Log in as Francie Frontline to see what workflow changes are designed for
frontline users.

To log in to the DemoHelpDesk Schema as Francie Frontline:
1. Choose Login from the File menu. The Login dialog box appears.

2. Type Francie Frontline in the User Name field. Leave the password
blank. Click the OK button.
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3. From the File menu, choose Open Query. The Select Schema - Query
dialog box appears, as shown in Figure 2-10.

Figure 2-10 Select Schema - Query Dialog Box
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4. Choose DemoHelpDesk from the list and click the OK button. The
DemoHelpDesk schema appears, and should look similar to Figure 2-11:

Figure 2-11 Francie Frontline’s View of the DemoHelpDesk Schema

You have just opened a Query window containing the DemoHelpDesk
schema. Query windows are used primarily by users who will be searching
the database, and making modifications.

Notice that Francie’s view of the DemoHelpDesk schema is different. It is
optimized for front line help desk personnel. Francie’s view includes
buttons, as well as new fields like Phone, Submitted-by, Arrival Time, and
Status. Francie needs this additional information to resolve tickets.

Front Line Technician Examines Call Queue

Francie needs to determine her workload. She can browse through the
DemoHelpDesk entries and search for the tickets assigned to her, but in this
case some workflow has been created to make the task easier.
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To get the details of the newly assigned call:
1. On the DemoHelpDesk schema, click in the button labeled List My Open

Calls. This performs a query of DemoHelpDesk tickets and lists the calls
in Francie’s work queue, as shown in Figure 2-12.

Figure 2-12 All Tickets Currently Assigned to Francie Frontline

Note – The List My Open Calls button is an active link that queries all entries
in the DemoHelpDesk schema with Francie Frontline in the Assigned-to field
and a Status other than closed.

2. Double-click the entry displaying the words “Cannot access Remedy
home page.” Joe User’s ticket is displayed in Modify Individual mode,
allowing Francie to modify portions of the ticket.

3. Review the information in the ticket by clicking the book icon
to the right of the Work Log field.
Notice the icon is a book with writing on the pages, indicating data has been
entered in this diary. Notice also Joe User’s previous entry describing the
step he has already taken. It has been stamped with his user name, and the
time the entry was made.

Upon review, Francie sees that Joe could not find an appropriate solution in
the solutions database.

4. Click Cancel to close the Work Log dialog box.

5. Close the Query List by double-clicking the control box in the upper-left
corner of the window.
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Front Line Queries DemoHelpDesk Database for Resolution

Francie decides to query the DemoHelpDesk database for closed calls fitting
this problem type. Perhaps a ticket similar to this has been resolved in the past,
and she can use that information in this instance. The search Joe performed
earlier was against the Solutions database. Francie will search the HelpDesk
database to see if a solution has been found but not submitted to the Solutions
database.

Several times in this demonstration, you have automated queries through the
use of active links in menu selections and buttons. As Francie, you will now
perform a query-by-example to generate a query for a solution. You will use
this method to see a list of closed DemoHelpDesk tickets with a Problem Type
of Software and Item Affected of Web Browser.

To use the database to find possible solutions:
1. Choose Query Window from the Window menu option. This brings a

blank Query Window to the front.

2. From the menu in the Problem Type field, choose Software.

3. From the menu in the Item Affected field, choose Web Browser.

4. From the menu in the Status field, choose Closed.
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5. From the Query menu, select List. Or, use the toolbar button.
A list of all closed calls with matching criteria appears. In browsing the
entries returned, you see there is no entry specific to the issue Joe User is
reporting.

Figure 2-13 Query-by-Example Results

6. Close the Query List window by double-clicking the control box in the
upper-left corner of the window.
In this case, you viewed the query results in the list format. You could also
have chosen to view matching tickets in report or display format. In display
format, all fields in the ticket are displayed in read-only mode. Report
format offers output options including screen, file or printer.

7. From the Window menu, choose Modify Individual-DemoHelpDesk.
This brings Joe User’s ticket back to the foreground.
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Front Line Reassigns Ticket to a More Experienced Staff Member

Francie needs to enter information about the steps taken so far, and reassign
the call to a more experienced help desk staff member. She will begin by
making an entry in the Work Log field. The Work Log is a diary field that
keeps a running record of actions taken on the ticket.

To enter work data and reassign the ticket:
1. Make an entry into the Work Log by clicking the book icon to the right of

the Work Log field.

Type the following text in the Editor box:

No solution in the solutions schema or DemoHelpDesk database.
Bob, weren’t you able to access the Remedy home page last week?
Please look in to this request.

Figure 2-14 The Work Log Diary

2. Click the OK button to close the Work Log data entry box.



Help Desk Demonstration for Windows 27

2

3. Assign the call to Francie’s colleague, Bob Backline, who has more
experience with Web Browsers.
Click the menu icon to the right of the Assigned-to field, and select Bob
Backline.

Figure 2-15 Francie Reassigns the Ticket

4. Choose Apply from the Actions menu, to apply the changes to the
request. Note the message that is displayed on your screen.

5. Click the OK button to dismiss the message.

6. Close the Modify Individual window by double-clicking the control box
in the upper-left corner of the window.
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7. Check Francie’s queue again by clicking the List My Open Calls button.
Notice that Joe User’s call is no longer in her queue, allowing Francie to
proceed to other tickets.

Figure 2-16 Francie Re-checks her Tickets

8. Close the Query List by double-clicking the control box in the upper-left
corner of the window.

9. Click the Next Demo Step button to prepare the User Tool for the next
section.

10. Close the Query window by double-clicking the control box in the
upper-left corner of the window.

11. From the File menu, choose Login. The Login dialog box appears.

12. Type Bob Backline  in the User Name field, and leave the password blank.
Click OK.

13. Minimize the User Tool by clicking the down arrow in the top-right
corner of the window.
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Section Conclusion

Now you have seen how help desk staff can use the capabilities of the AR
System to work on a call. In this section, you have learned that:

• The frontline technician has a different view of the help desk application.
Much as the user view is optimized for quick and easy submission by
occasional users, the frontline view is optimized for nearly full time use by
frontline technicians to manage their work queues and to resolve calls
quickly.

• Common steps used by help desk personnel can be automated as part of the
schema view. Automation can be driven through menu selections, buttons
and applying changes to the database. Automation provided the frontline
technician with information on open calls and possible solutions.

• A solution schema is a primary aid for help desk personnel to quickly
resolve calls. You can build solution schemas to include common problems
at your site.

Backline Technician is Notified of a Ticket
In this section you will assume the role of Bob Backline, the backline
technician, and begin with a different tool — the Action Request System
Notification Tool. The Notification Tool works like a desktop pager to alert
help desk staff members of any requests that require their attention.

Backline Technician Retrieves the Ticket in the Notification Tool

Bob sees that a call has been assigned to him via the Notification Tool. Bob
retrieves the notification and reviews the call in the User Tool.

To retrieve the DemoHelpDesk ticket in the Notification Tool:
• Double-click the AR Notifier icon in the Remedy AR System program group

to launch the AR System Notification Tool.
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Figure 2-17 Notification Icon in the Remedy AR System Program Group

A message appears in the Notification Tool to inform Bob that he has been
assigned a new Medium Priority call.

Figure 2-18 Notification of Assignment

To customize the Notification Tool to set User Tool retrieval preferences:
1. Choose Preferences from the File menu. The Notification Tool Preferences

dialog box appears, as shown in Figure 2-19.

2. Select Modify in the Action for Get Details box, then click the OK button.
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Figure 2-19 Notification Tool Preference Window with Get Details Action Specified
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To get details of a DemoHelpDesk ticket notification:
• Double-click the entry in the Notification Tool to open the associated ticket.

With this action, you open the AR System User Tool, and open the
DemoHelpDesk ticket in Modify mode. This makes it possible for you to
add information to the ticket as soon as you receive it.

Figure 2-20 Get Details in a Modify Individual Window

In this part of the demonstration, you have learned that:

• The Notification Tool is like a desktop pager, alerting you of issues that
require your attention.

• Notification is driven by business rules specified by your system
administrator. These rules can be changed to meet your specific needs
through the AR System Administrator Tool, discussed later in this chapter.

• The AR System Notification and User Tools are linked. Double-clicking an
entry in the Notification Tool opens the User Tool and displays the details of
your call.



Help Desk Demonstration for Windows 33

2

Backline Technician Resolves the Call

Drawing from his experience with Web Wanderer, Bob is able to recommend a
solution to Joe’s request. Bob will provide a solution by outlining the steps Joe
can take to access Remedy’s Home Page, and will then close the call. In
addition, Bob’s actions are stored in the AR System for others to use as a
solution in the future.

While reviewing the ticket, notice that you are now displaying a third view
that is optimized for back line staff members. Problem description and
problem resolution information is emphasized at the top of this view, while
contact information is de-emphasized.

To review the call and provide the resolution:
1. Review the Problem Type, Item Affected and Problem Summary fields.

In reviewing this information, Bob realizes Joe needs to define the proxy
information for his Web Wanderer configuration.

2. Click the book icon to the right of the Work Log field, and enter the
solution details in the editor box:

Select proxies under Web Wanderer’s options menu.

Find the line for http protocol.

Set the proxy server to “firestorm”.

Set the proxy port to “80”.

3. Click the OK button to close the Work Log field data entry box.
Bob now contacts Joe and they review the steps outlined in the Work Log.
Upon completing these steps, Joe is able to access Remedy Corporation’s
home page on the World Wide Web.

4. Click the Possible Solutions field and type:

Specify a proxy server and a proxy port.

This displays a short summary of the actions detailed in the Work Log field.
This information can be used for end users to research problem resolutions.
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Backline Technician Closes the Call

To close the call:
1. In the Status field, change the Status to Closed.

2. Choose Apply from the Actions menu to apply the changes to the ticket.
You can also click the Apply button on the toolbar. Notice the notification
message displayed on your screen.

Figure 2-21 Notification of Closed Call

3. Click the OK button to dismiss the message.

4. Click the Next Demo Step button to prepare the User Tool for the next
section.

5. Close the Modify Individual window by double-clicking the control box
in the upper-left corner of the window.

6. Minimize the User Tool and the Notification Tool.
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Section Conclusion

In this part of the demonstration, you learned that:

• The help desk, working as a team and using the Action Request System, is
able to resolve the call quickly. While the call is initially assigned to a help
desk staff member who could not resolve the call, reassignment and
notification features of the AR System directed the request to a technician
with the proper experience.

• Closed calls remain in the database to allow system users to access past
calls. This also allows help desk managers to generate performance reports.

End User Notification of Call Closure
The workflow is now coming full circle. Joe User submitted his call to the help
desk. Francie, the front line engineer, realized she did not have the expertise or
access to the knowledge needed to resolve the request. Francie reassigned the
ticket to Bob, a backline software specialist. The AR System notified Bob of the
reassignment and Bob acted on the request and communicated the solution to
Joe User. Finally, in this step, the AR System notifies Joe of the solution, and
informs him the call is closed.

To log in to the Notification Tool and review the DemoHelpDesk ticket:
1. Restore the AR System Notification Tool by double-clicking the

AR Notifier icon.

2. Choose Login from the File menu. The Login dialog box appears.

3. In the User Name field, type Joe User.  Leave the password blank. Click
the OK button.
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Figure 2-22 End User Closed Call Notification

A message informing Joe User of the closed call appears in the Notification
Tool.

4. Exit the Notification Tool by double-clicking the control box in the
upper-left corner of the tool, then clicking Yes in the warning box which
appears.

Section Conclusion

You have learned the following attributes of the AR System:

• The Notification Tool can alert users of closed calls, just as it alerts help desk
personnel of assigned calls.

• Because Bob Backline entered the solution details in the work log, the
information can be used by other users and help desk staff members who
encounter the same problem.

• The AR System integrates robust problem management with problem
resolution aids and workflow processing, increasing the productivity of help
desk personnel and help desk customers.
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Administrator Adds a Field to the DemoHelpDesk Schema
In addition to strong workflow processing and problem resolution capabilities,
the AR System is highly customizable. In this step you will add a field to the
DemoHelpDesk schema for the user to describe his satisfaction with the service
of his request. At the conclusion of this demo, you will see this new field
added to the schema.

To log in to the AR System Administrator Tool:
1. Double-click the AR Admin icon to launch the AR System Administrator

Tool. The Login dialog box appears.

Figure 2-23 Administrator Tool in the AR Program Group

2. Make sure Bob Backline is in the User Name field. Leave the password
blank. Click the OK button.

To select an object to modify:
1. Double-click the server name listed on the left side of the Server window.

A list of AR System object categories is displayed, as shown in
Figure 2-24.
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Figure 2-24 Database Object Categories

2. Double-click the Schemas icon.
The right hand window displays a list of all schemas on this server.

3. Double-click DemoHelpDesk to open the DemoHelpDesk Schema for
modification. The Modify Schema window appears.

To create a new field:
1. From the Schema menu, choose Create New Field and pull right to choose

Selection. The new field is added in the top left corner of the schema, as
shown in Figure 2-25.
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Figure 2-25 New Field Added to Schema

2. Click in the center of the new field and hold the mouse button. Drag the
field down to just below the Work Log field. Release the mouse button.

To define field properties:
1. Double-click the new field to open the Field Properties dialog box for the

new field. This dialog box is a tabbed dialog box. Often, you will enter
data in each of the panels, but in this lesson, we will change only three.

2. On the first tab, labeled Display, change the contents of the Label field to
Customer Satisfaction . Notice that the changes you make are
immediately reflected on the screen.

3. Change the location definition for the label to Top.
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Figure 2-26 Changing the Text and Placement of the Field Label

To define selection field values:
1. Click the Attributes tab.

2. Remove Default 1 from the Value box and replace it with: Improve.  Click
the Modify button.

3. Double-click Improve in the Value box and type: Average . Click the Add
Before button.

Figure 2-27 Field Selection Values

4. Double-click Average in the Value box and type: Excellent.  Click the
Add Before button.
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To define field permissions:
1. Click the Permissions tab.

2. By default, only members of the Administrator group have access to a
newly created field. Select Submitter in the No Permission box and click
the Add button to add this group to the Permission box.

3. Click the eyeglass menu button next to Submitter and choose Change
permission. Note that the eyeglass menu button switched to a pencil
menu button, indicating that you have switched the setting for this field
from view permission to change permission for the Submitter group.

4. Select Public from the No Permission box and click the Add button to add
this group to the Permission box.

Figure 2-28 Field Permissions Based on Group Membership

5. Close the Field Properties dialog box by double-clicking the control box
in the upper-left corner of the box.

Note – Field permissions protect sensitive information. By giving Public view
access to a field, you allow any AR System user to view the field’s contents. In
this instance, however, only the Submitter can change the field’s contents. For
more information on field permissions, see the Action Request System
Administrator’s Guide.
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To save modifications to the schema:
1. Choose Save Schema from the File menu.

2. Close the Modify Schema window by double-clicking the control box in
the upper-left corner of the window.

3. Minimize the Administrator Tool.

View the New Field

Log in to see the new field. When an administrator makes a change to any
aspect of a schema, the users simply log in to retrieve the changes.

To open the DemoHelpDesk schema in the AR System User Tool:
1. Double-click the AR System User Tool icon to launch the User Tool.

2. From the File menu, choose Login. The Login dialog box appears.

3. Make sure Joe User is in the User Name field. Leave the password blank
and click OK.

4. Choose Open Submit from the File menu. The Open Submit dialog box
appears.

5. From the schema list, select DemoHelpDesk, then click the OK button.
The DemoHelpDesk schema appears, as shown in Figure 2-29. Notice that
the field you just added is displayed and usable.
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Figure 2-29 New Field on the DemoHelpDesk Schema

6. Exit the User Tool by choosing Exit from the File menu.

Section Conclusion

In this part of the demonstration, you added a new field to the DemoHelpDesk
schema, without directly accessing the underlying database. You have seen
that:

• Through a series of point-and-click operations, you were able to add a field
to a schema. No knowledge of relational databases or programming
languages is required.

• The AR System offers rich control of how fields are displayed. You specified
the location of the field and the field’s label. The selection list is presented as
radio buttons, but with the click of a button, it could be displayed as a
menu.

• You can use the Administrator Tool to define additional workflow objects,
such as active links, filters and escalations. Creating and modifying these
objects is as simple as creating a new field.
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Congratulations!
You have now completed a very brief overview of how you can use the AR
System to automate the workflow of an internal help desk application. You
have seen how users and help desk personnel can work together to resolve
requests. Included with the Help desk applications are workflow rules and a
solutions database that can enhance service quality, lead to consistent service
for every request, and even reduce costs.

You worked with the desktop beeper feature, the Notification Tool. You also
worked with the Administrator Tool to explore ways you can design schemas
and workflow rules to meet your organization’s business needs. Without any
programming, you defined and added a selection field to the schema. With
similar ease, you can create your own AR System applications or customize the
sample schemas provided with the AR System.

Restoring the Demonstration Environment

During the Help Desk demonstration, you made some changes to the default
demonstration environment. If you wish to start the demonstration over, or
restore it for another user, follow the procedure below.

To restore the demonstration environment:
1. Maximize the AR System Administrator Tool by double-clicking its icon.

2. Double-click the server name listed in left side of the Server window. A
list of AR System object categories is displayed.

3. Double-click the Schemas icon. The right hand window displays a list of
all schemas stored on this server.

4. Double-click DemoHelpDesk to open the DemoHelpDesk schema for
modification.

5. Click the Customer Satisfaction field to highlight this field.

6. From the Edit menu, choose Delete.

7. Click Yes To All at the “Are you sure that you wish to delete/cut Field:
Customer Satisfaction” prompt.

8. Click OK in the box which informs you of the changes you will make.
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9. From the File menu, choose Save Schema.

10. Minimize the Administrator Tool.

Where to Go from Here
Now that you have successfully completed the AR System Help Desk
Demonstration, you can proceed to other tasks. Remedy provides some helpful
products to help you understand more about the processes you would like to
implement, as well as how to use the AR System to achieve these goals. This
section lists some suggested directions in which to proceed to get your help
desk completed.

Review the Sample Schemas Included with the AR System

The Action Request System provides a suite of sample schemas that you can
review to understand process definition and implementation. For more details,
see Chapter 4.

Install the AR System Help Desk Template

Your AR System package includes a CD with the AR System Help Desk
Template. This template contains a group of schemas that you can use for
internal help desk applications. The template includes sophisticated workflow
already defined to aid in problem definition and resolution, auto assignment of
tickets based on problem type, and the ability to access and modify the
solutions database from the HelpDesk schema. For more information on the
AR System Help Desk Templates, see the accompanying Help Desk Templates
Guide for Users and Administrators.

Start Developing Your Own Help Desk Application

If you feel comfortable in the process definition at your site, and in your ability
to create defined workflow with the AR System, you can start creating your
own schemas, active links, filters and escalations with the AR System
Administrator Tool. For more information regarding workflow definition and
implementation, see the Action Request System Administrator’s Guide.
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Once you have installed the AR System server and client tools, you are ready
to experiment with the software. Your AR System package comes with two
demonstrations to help you learn about the benefits, features, and functionality
of Remedy’s Action Request System, the leading help desk Solution. The first
demonstration is the self-running Action Request System Demo Disk. Use the
demonstration diskette on any UNIX station or Windows PC to learn about the
key benefits and uses of the AR System. Install and run the demo according to
the instructions on the disk label.

The second demonstration is the Help Desk Demonstration, which is described
in this chapter. It features live use of the AR System Server and Tools and is a
great way to familiarize yourself with the operation of the AR System. You will
follow a detailed script to track a problem from initial submission to closure,
learning about the design and functionality of the AR System along the way.
Additionally, you will learn how to use the Administrator Tool to customize
applications. The complete demonstration consists of five sections and, if you
are a first time user, takes about 45 minutes to complete.

By working through the demonstration, you will:

• See how a team works together and, with the aid of pre-defined, site-specific
workflow rules, quickly resolves user requests for assistance.

• Learn the basics of how to use the AR System User, Notification and
Administrator Tools.

• See ways to use the AR System to automate your business workflow.
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Introducing Joe, Francie, and Bob
This scenario introduces you to three people — Joe User, Francie Frontline, and
Bob Backline. Joe, Francie and Bob represent three types of users who can take
advantage of the AR System in a typical help desk environment.

During the course of this Help Desk demonstration, you will at some point
assume the role of each user. Let’s meet them now:

Joe User: Joe is an AR System end user. Running the AR
System is not Joe’s main job. In fact, Joe needs to run the AR
System User Tool only when he has a problem with the
hardware or software that he does use regularly. Joe can also
run the AR System Notification Tool to ensure that he is
notified when any problem he submits is fixed. Joe is
experiencing problems connecting to Remedy Corporation’s
Home Page on the World Wide Web (WWW). He will submit a
help desk ticket to get the problem resolved.

Francie Frontline: Francie is a first line support staff member.
She typically submits calls and acts as a generalist for problem
resolution at the company’s internal help desk. In this role, she
attempts to resolve each issue, and, if she is unable to do so,
assigns incoming requests for help to the appropriate help desk
staff member. She then follows up to make sure all problems
are resolved in a reasonable period of time.

Bob Backline: Bob usually gets calls assigned to him from
other support staff members. As a back line staff member, Bob
is a specialist with a more narrow area of expertise than the
front line staff. He resolves the call and updates information in
the ticket.
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Now it’s time to start the Help Desk demonstration and have some fun. You
will follow a single problem through a simple problem resolution process. In
some cases, an Administrator’s Note outlines the workflow process used to
create the actions you see happening in the demonstration.

The demonstration script will guide you through the keystrokes you need to
make to complete each step.

Starting the Demonstration
When you installed the AR System server, a directory named demo was created
in the directory where you installed the AR System (<install_dir >). By
default, this directory is /usr/ar/demo . The demo directory contains setup
scripts for each user (Joe, Francie, and Bob). In order to run the Help Desk
demonstration, you need to run the arDemoStartup  script, which launches the
AR System tools for Joe, Francie, and Bob.

Note: In a real work environment, each of these users would be running their AR Sys-
tem tools on separate machines. In this demonstration, we simulate three sepa-
rate machines by displaying each user’s AR System tools in different corners of
your screen.

1. Submit new problem.

2. Analyze and
possibly reassign
problem.

3. Fix problem.
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By issuing the following commands, you will both change to the directory in
which the AR System was installed, and start the arDemoStartup  script:

cd /<install_dir>/demo

arDemoStartup

If you get Xlib errors, you may need to enter the command xhost +  before you
run the arDemoStartup  script.

Once you have started the demonstration, your monitor will show the various
tools of the three members of the sample Help Desk. Joe User’s tools are in the
upper-right portion of the screen, Francie Frontline’s tools are in the lower-left
corner, and Bob Backline’s station is in the lower-right area of the screen.

Figure 3-1 Demonstration Workspace
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An Internal User Submits a Ticket
The Computing Services Group recently installed two new pieces of software
on Joe User’s computer: the Remedy Action Request System User Tool and
Web Wanderer, a WWW browser. Joe is very interested in accessing
information from the WWW and attempts to locate the Remedy Corporation
home page at http://www.remedy.com .

While the Web browser itself seems to function properly, Joe’s browser
displays an error message when he tries to access the Remedy home page.
Anxious to get beyond the error, Joe proceeds to use his other new software
tool, the AR System User Tool, to initiate a service request with his internal
help desk. The help desk trainer has told Joe that the AR System User Tool is
like dialing 911, with calls going directly to the help desk. Joe decides to make
his call to the help desk using the new tool.

Open the DemoHelpDesk Schema

In this section, you will act as Joe User and begin by opening the
DemoHelpDesk schema in your User Tool. A schema is a form that represents
a set of related data in the AR System database. The DemoHelpDesk schema is
designed to be used for service requests.

To open the DemoHelpDesk schema as Joe User:
1. Open Joe’s AR System User Tool by double-clicking the User Tool icon in

the upper-right portion of your screen.
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Figure 3-2 Demonstration Workspace — Joe’s User Tool

2. Select Open Schema from the File menu. The Open Schema dialog box
appears.

Figure 3-3 Open Schema Dialog Box
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3. Double-click the entry for the DemoHelpDesk schema. The
DemoHelpDesk query window appears, and should look similar to
Figure 3-4.

Figure 3-4 End User View of the DemoHelpDesk Schema

You have just opened a Query window containing the DemoHelpDesk
schema. Query windows differ from submit windows. Query windows are
used primarily by users to query the database, and make modifications to
existing data.

4. From the File menu, select Open Submit. A Submit window for the
DemoHelpDesk schema appears.
Joe User can submit a record of his particular problem using the submit
window for the schema.

You have successfully entered the AR System as Joe User, selected the schema
used for entering problems, and opened a submit window for that schema.
Next, you will fill in the information regarding the problem Joe is having.

Provide Information About the Request

Joe needs to provide information to the help desk staff about the problem he is
encountering. Typically, a user such as Joe provides the help desk with details
about himself, as well as the problem.
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To fill the DemoHelpDesk ticket with pertinent information:
1. In the Employee Id field, type 3000 and press Enter.

Since Joe User has contacted the help desk in the past, his caller record
exists and information about him is on file. When you press Enter, notice
Joe’s first and last name are automatically filled in.

Figure 3-5 DemoHelpDesk Schema with Auto-Filled Data

Note – The auto-fill capability demonstrated here is achieved by an active link.
The active link takes the employee number as query criteria, queries the
DemoHD:CallerDetail schema for a match, and returns the data.

2. Locate the Problem Type field. Click the character menu icon,  and
select Software from the menu.

3. Locate the Item Affected field. Click the character menu icon to the right
of the field, then select Web Browser.
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Figure 3-6 Query Menu on the DemoHelpDesk Schema

Notice that all selections in the Item Affected field menu are related to
software. This information is based on the previous selection made in the
Problem Type field.

Note – The values of the Item Affected fields are provided by a query style
menu, which takes the criteria to match from the Problem Type field. It then
queries the DemoHD:ItemAffected schema to find all entries related to a
Problem Type definition of Software.

End User Searches for the Solution

Joe has the ability to check the solutions database to see if a similar problem
was reported in the past, and what the resolution might be.

To search the Solutions database from the DemoHelpDesk schema:
1. In the Possible Solutions field, click the character menu icon.
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Figure 3-7 Possible Solutions Displayed on DemoHelpDesk

The AR System shows all known solutions matching the contents of the
Problem Type and Item Affected fields. Joe reviews these solutions, and
realizes none apply to the problem he is encountering.

Note – The ability to search the possible solutions database is achieved with a
query style menu. This menu queries the DemoHD:Solutions schema for all
entries with matching values for the Problem Type and Item Affected fields.

2. Since none of the possible solutions are appropriate, release the mouse
button to dismiss the menu selections.

3. In the Problem Summary field, type: Cannot access Remedy home page .

4. Click the text editor icon  to the right of the Problem Detail field.
Click in the Problem Detail text editor that opens, then type: Using Web

Wanderer 2.1 for Motif. Error message: fatal error 500; can’t

access document.
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Figure 3-8 Problem Detail Text Field in the DemoHelpDesk Schema

5. Click Apply to close the text editor.

6. In the Work Log field, type in the following text:
Did not see a logical solution in Possible Solutions list.
Please analyze.

7. Click the Impact selection field. Select Medium.

Submit the Request to the Help Desk Staff

Once Joe has finished filling in the necessary information and submitted the
ticket, the help desk staff will help him resolve his problem.

To submit the ticket to the database:
You have entered all data needed for problem submission. Now submit the
ticket.

The Call ID field will fill in automatically when you submit the ticket.
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1. Click Apply to submit the request. When you submit the ticket, notice
that a message is displayed on your screen, as shown in Figure 3-9.

Figure 3-9 Notification of Assignment

Note – The message is achieved with a filter. This filter has two actions. The
first displays a message to the submitter, letting Joe know the ticket is assigned
to Francie. The second action notifies the assignee of the new ticket.

2. Click Dismiss to dismiss the message.
In the lower portion of the window, you see the text:

Submit Successful-ID=xxxxxx
where xxxxxx  is a number representing Joe’s ticket ID. He can refer to this
ticket number when contacting the help desk regarding this request.

3. Click Dismiss to close the Submit window.

4. Minimize Joe’s User Tool.
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Section Conclusion

You have successfully submitted a call. So far, you have learned the following:

• End user participation is encouraged with the AR System. End users
commonly submit their own requests, and even perform self help. Help
desk staff can focus their efforts on resolving requests, while end user
satisfaction is enhanced through participation.

• Some fields require data entry, while others can be automatically filled out
by the system. Menu selections simplify data entry even further.

• The AR System can route tickets automatically to the appropriate staff
members, and notify them using the Notification Tool. The Notification Tool
is explained in greater detail later in the demonstration.

• End users have a simple view of the help desk application, making data
entry quick and easy. Users can be successful with minimal training.

Frontline Technician Works on the Submitted Call
Now that you have entered a new call as Joe User, you will assume the role of
Francie Frontline, a help desk technician, and bring the call to resolution. As
you saw in the previous section, Francie Frontline has been assigned Joe’s call.
This assignment was made by the system and was based on a defined business
rule: Assign all software problems to Francie Frontline. The Action Request
System allows you to simply define and change business rules for processing
any request. In this lesson, you will see how the help desk responds to the call.

Assume the Role of the Front Line Staff Member

Open Francie Frontline’s User Tool to see what workflow changes are designed
for frontline users.

To use the DemoHelpDesk schema as a frontline staff member:
1. Find Francie Frontline’s User Tool in the lower-left portion of your screen.

2. Double-click the User Tool icon. Francie’s User Tool opens with the query
window for the DemoHelpDesk schema already present.
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Figure 3-10 Francie Frontline’s View of the DemoHelpDesk Schema

Notice that Francie’s view of the DemoHelpDesk schema is different. It is optimized
for front line help desk personnel. Francie’s view includes buttons, as well as new
fields like Phone, Submitted-by, Arrival Time, and Status. Francie needs this
additional information to resolve tickets.

Front Line Technician Examines Call Queue

Francie needs to determine her workload. She can browse through the
DemoHelpDesk entries and search for the tickets assigned to her, but in this
case some workflow has been created to make the task easier.
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To get the details of the newly assigned call:
1. On the DemoHelpDesk schema, click the button labeled List My Open

Calls. This performs a query of DemoHelpDesk tickets and lists the calls
in Francie’s work queue, as shown in Figure 3-11.

Figure 3-11 All Tickets Currently Assigned to Francie Frontline

Note – The List My Open Calls button is an active link that queries all entries
in the DemoHelpDesk schema with Francie Frontline in the Assigned-to field
and a Status other than closed.

2. Double-click the entry displaying the words “Cannot access Remedy
home page.” Joe User’s ticket is displayed in Modify Individual mode,
allowing Francie to modify portions of the ticket.

3. Review the information in the ticket by clicking the book icon to the right
of the Work Log field.

Notice the icon is a book with writing on the pages, indicating data has been
entered in this diary. Notice also Joe User’s previous entry describing the
step he has already taken. It has been stamped with his user name, and the
time the entry was made.

Upon review, Francie sees that Joe could not find an appropriate solution in
the solutions database.

4. Click Dismiss on each to close the Work Log dialog box and Query List
window.
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Front Line Queries DemoHelpDesk Database for Resolution

Francie decides to query the DemoHelpDesk database for closed calls fitting
this problem type. Perhaps a ticket similar to this has been resolved in the past,
and she can use that information in this instance. The search Joe performed
earlier was against the Solutions database. Francie will search the HelpDesk
database to see if a solution has been found but not submitted to the Solutions
database.

Several times in this demonstration, you have automated queries through the
use of active links in menu selections and buttons. As Francie, you will now
perform a query-by-example to generate a query for a solution. You will use
this method to see a list of closed DemoHelpDesk tickets with a Problem Type
of Software and Item Affected of Web Browser.

To use the database to find possible solutions:
1. Select Clear All from the Edit menu to clear the fields in the schema.

2. From the menu in the Problem Type field, select Software.

3. From the menu in the Item Affected field, select Web Browser.

4. From the menu in the Status field, select Closed.

5. From the Query menu, select List.
A list of all closed calls with matching criteria appears. In browsing the
entries returned, you see there is no entry specific to the issue Joe User is
reporting.
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Figure 3-12 Query-by-Example Results

6. Close the Query List window by clicking Dismiss.
In this case, you viewed the query results in the list format. You could also
have chosen to view matching tickets in report or display format. In display
format, all fields in the ticket are displayed in read-only mode. Report
format offers output options including screen, file or printer.

7. From the Windows menu, select Modify Individual.
This brings Joe User’s ticket back to the foreground.

Front Line Reassigns Ticket to More Experienced Staff Member

Francie needs to enter information about the steps taken so far, and reassign
the call to a more experienced Support Staff member. She will begin by making
an entry in the Work Log field. The Work Log is a diary field that keeps a
running record of actions taken on the ticket.
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To enter work data and reassign the ticket:
1. Make an entry into the Work Log by clicking the book icon to the right of

the Work Log field.

Type the following text in the editor box:

No solution in the solutions schema or DemoHelpDesk database.
Bob, weren’t you able to access the Remedy home page last week?
Please look into this request.

Figure 3-13 The Work Log Diary

2. Click Apply to close the Work Log data entry box.

3. Assign the call to Francie’s colleague, Bob Backline, who has more
experience with Web Browsers.
Click the menu icon to the right of the Assigned-to field, and select Bob
Backline.
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Figure 3-14 Francie Reassigns the Ticket

4. Click Apply to apply the changes to the request. Note the message that is
displayed on your screen.

5. Click Dismiss to dismiss the message.

6. Click dismiss to close the Modify Individual window.

7. Check Francie’s queue again by clicking the List My Open Calls button.
Notice that Joe User’s call is no longer in her queue, allowing Francie to
proceed to other tickets.
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Figure 3-15 Francie Re-checks her Tickets

8. Click Dismiss to close the Query List.

9. Minimize Francie’s User Tool.

Section Conclusion

Now you have seen how help desk staff can use the capabilities of the AR
System to work on a call. In this section, you have learned that:

• The frontline technician has a different view of the help desk application.
Much as the user view is optimized for quick and easy submission by
occasional users, the frontline view is optimized for nearly full time use by
frontline technicians to manage their work queues and to resolve calls
quickly.

• Common steps used by help desk personnel can be automated as part of the
schema view. Automation can be driven through menu selections, buttons
and applying changes to the database. Automation provided the frontline
technician with information on open calls and possible solutions.

• A solution schema is a primary aid for help desk personnel to quickly
resolve calls. You can build solution schemas to include common problems
at your site.
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Backline Technician is Notified of a Ticket
In this section you will assume the role of Bob Backline, the backline
technician, and begin with a different tool — the Action Request System
Notification Tool. The Notification Tool works like a desktop pager to alert
Help Desk staff members of any requests that require their attention.

Backline Technician Retrieves the Ticket via Notification Tool

Bob sees that a call has been assigned to him, via the Notification Tool. Bob
retrieves the notification and reviews the call in the User Tool.

To retrieve the DemoHelpDesk ticket from the Notification Tool:
• Double-click Bob’s AR System Notification Tool icon in the lower-right

corner of your screen to launch the AR System Notifcation Tool.
A message appears in the Notification Tool, informing Bob that a new
Medium Priority call has been assigned to him.

Figure 3-16 Notification of Assignment

To get details of a DemoHelpDesk ticket notification:
• Double-click the entry in the Notification Tool to open the associated ticket.

With this action, you open the AR System User Tool, and open the
DemoHelpDesk ticket in Modify mode. This makes it possible for you to
add information to the ticket as soon as you receive it.
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Figure 3-17 Get Details in a Modify Individual Window

In this part of the demonstration, you have learned that:

• The Notification Tool is like a desktop pager, alerting you of issues that
require your attention.

• Notification is driven by business rules specified by your System
Administrator. These rules can be changed to meet your specific needs
through the AR System Administrator Tool, discussed later in this chapter.

• The AR System Notification and User Tools are linked. Double-clicking an
entry in the Notification Tool opens the User Tool, and displays the details
of your call.

Backline Technician Resolves the Call

Drawing from his experience with Web Wanderer, Bob is able to recommend a
solution to Joe’s request. Bob will provide a solution by outlining the steps Joe
can take to access Remedy’s Home Page, and will then close the call. In
addition, Bob’s actions are stored in the AR System for others to use as a
solution in the future.
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While reviewing the ticket, notice that you are now displaying a third view
that is optimized for back line staff members. Problem description and
problem resolution information is emphasized at the top of this view, while
contact information is de-emphasized.

To review the call and provide the resolution:
1. Review the Problem Type, Item Affected, and Problem Summary fields.

In reviewing this information, Bob realizes Joe needs to define the proxy
information for his Web Wanderer configuration.

2. Click the book icon to the right of the Work Log field, and enter the
solution details in the box at the bottom of the Work Log:

Select proxies under Web Wanderer’s options menu.

Find the line for http protocol.

Set the proxy server to “firestorm”.

Set the proxy port to “80”.

3. Click Apply to close the Work Log field data entry box.
Bob now contacts Joe and they review the steps outlined in the Work Log.
Upon completing these steps, Joe is able to access Remedy Corporation’s
home page on the World Wide Web.

4. Click the Possible Solutions field and type:

Specify a proxy server and a proxy port.

This displays a short summary of the actions detailed in the Work Log field.
This information can be used for end users to research problem resolutions.

Backline Technician Closes the Call

To close the call:
1. In the Status field, change the Status to Closed.

2. Click Apply to save the changes to the ticket. Notice the notification
message displayed on your screen.
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Figure 3-18 Notification of Closed Call

3. Click Dismiss to dismiss the message.

4. Click Dismiss to close the Modify Individual window.

5. Minimize Bob’s User Tool and Notification Tool.

Section Conclusion

In this part of the demonstration, you learned that:

• The help desk, working as a team and using the Action Request System, is
able to resolve the call quickly. While the call is initially assigned to a Help
Desk staff member who could not resolve the call, reassignment and
notification features of the AR System directed the request to a technician
with the proper experience.
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• Closed calls remain in the database allowing system users to access past
calls, and allows help desk management to generate performance reports.

End User Notification of Call Closure
The workflow is now coming full circle. Joe User submitted his call to the help
desk. Francie, the front line technician, realized she did not have the expertise
or access to the knowledge needed to resolve the request. Francie reassigned
the ticket to Bob, a backline software specialist. The AR System notified Bob of
the reassignment and Bob acted on the request and communicated the solution
to Joe User. Finally, in this step, the AR System notifies Joe of the solution, and
informs him the call is closed.

To review DemoHelpDesk tickets:
1. Open Joe’s Notification Tool by double-clicking the AR Notifier icon in

the upper-right portion of your screen.

Figure 3-19 End User Closed Call Notification

A message informing Joe User of the closed call appears in the Notification
Tool.

2. Minimize the Notification Tool.

Section Conclusion

You have learned the following attributes of the AR System:
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• The Notification Tool can alert users of closed calls, just as it alerts help desk
personnel of assigned calls.

• Because Bob Backline entered the solution details in the work log, the
information can be used by other users and help desk staff members who
encounter the same problem.

• The AR System integrates robust problem management with problem
resolution aids and workflow processing, increasing the productivity of help
desk personnel and help desk customers.

Administrator Adds a Field to the DemoHelpDesk Schema
In addition to strong workflow processing and problem resolution capabilities,
the AR System is highly customizable. In this step you will add a field to the
DemoHelpDesk schema for the user to describe his satisfaction with the service
of his request. At the conclusion of this demo, you will see this new field
added to the schema.

To add a field to a schema using the AR System Administrator Tool:
1. Double-click Bob’s AR System Administrator Tool icon to open the

Administrator Tool.

Figure 3-20 Demonstration Workspace — Francie’s Administrator Tool
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2. Select Login from the File menu. The Login dialog box appears. Make
sure Bob Backline is in the User Name field. Leave the password blank.
Click Apply.

3. From the Category menu, select Schemas.

4. Double-click DemoHelpDesk to open the DemoHelpDesk Schema for
modification. The Modify Schema window appears.

5. From the Views menu, pull right on Select and select End User (UNIX) to
modify the view with which Francie’s end users will work.

To create a new field:
1. From the Edit menu, select New Field. The new field is added in the top

left corner of the schema. The Field Properties dialog box for the new
field also appears.
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Figure 3-21 New Field Added to Schema

2. Click in the center of the new field and hold the mouse button. Drag the
field down to just below the Work Log field. Release the mouse button.

To define field properties:
The Field Properties dialog box contains several settings. Often, you will enter
data in many of the panels, but for this lesson, you will make few changes.

1. Change the Data Type field to Selection.

2. Change the contents of the Label field to Customer Satisfaction .

3. For the Label Position field, select Top.
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To define selection field values:
1. Click Selection Values. The Selection Values dialog box appears.

2. Select the Choice box and type Excellent . Click Append.

3. Select the Choice box and type Average . Click Append.

4. Select the Choice box and type Improve . Click Append.

Figure 3-22 Field Selection Values

5. Click Apply in the Selection Values dialog box to save the values for the
new field.

6. Click Dismiss to close the Selection Values dialog box.

To define field permissions:
1. By default, only members of the Administrator group have access to a

newly created field. Find Submitter in the Group Permissions List. Select
the Change option next to Submitter to allow this group to change the
value of this field.

2. Find Public in the Group Permissions list. Select the View option to allow
everyone with access to this schema the ability to view this field.
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Note – Field permissions protect sensitive information. By giving Public view
access to a field, you allow any AR System user to view the field’s contents. In
this instance, however, only the Submitter can change the field’s contents. For
more information on field permissions, see the Action Request System
Administrator’s Guide.

3. Click Apply in the Field Properties dialog box to save the changes to the
new field.

4. Click Dismiss to close the Field Properties dialog box.

To save modifications to the schema:
1. Click Apply in the Modify Schema window to save the changes made to

the schema.

2. Click Dismiss to close the Modify Schema window.

3. Minimize the Administrator Tool.

View the New Field

Log in to see the new field. When an administrator makes a change to any
aspect of a schema, the users simply log in to retrieve the changes.

To open the DemoHelpDesk schema in the AR System User Tool.
1. Double-click Joe’s AR System User Tool icon to launch his User Tool.

2. Choose Open Schema from the file menu. The Open Schema dialog box
appears.

3. From the schema list, select DemoHelpDesk, then click Apply. The
DemoHelpDesk schema appears, as shown in Figure 3-23. Notice that the
field you just added is displayed and usable.
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Figure 3-23 New Field on the DemoHelpDesk Schema

4. Minimize Joe’s User Tool.

Section Conclusion

In this part of the demonstration, you added a new field to the DemoHelpDesk
schema, without directly accessing the underlying database. You have seen:

• Through a series of point-and-click operations, you were able to add a field
to a schema. No knowledge of relational databases or programming
languages is required.

• The AR System offers rich control of how fields are displayed. You specified
the location of the field and the field’s label. The selection list is presented as
radio buttons, but with the click of a button, it could be displayed as a
menu.

• You can use the Administrator Tool to define additional workflow objects,
such as active links, filters, and escalations. Creating and modifying these
objects is as simple as creating a new field.
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Congratulations!
You have now completed a very brief overview of how you can use the AR
System to automate the workflow of an internal help desk application. You
have seen how users and help desk personnel can work together to resolve
requests. Included with the help desk application are workflow rules and a
solutions database that can enhance service quality, lead to consistent service
for every request, and even reduce costs.

You worked with the desktop beeper feature, the Notification Tool. You also
worked with the Administrator Tool to explore ways you can design schemas
and workflow rules to meet your organization’s business needs. Without any
programming, you defined and added a selection field to the schema. With
similar ease, you can create your own AR System applications or customize the
sample schemas provided with the AR System.

Restoring the Demonstration Environment

During the workflow demonstration, you made some changes to the default
demonstration environment. If you wish to start the demonstration over, or
restore it for another user, follow the procedure below.

To restore the demonstration environment:
1. Maximize the AR System Administrator Tool by double-clicking its icon.

2. From the Category menu, select Schemas.

3. Double-click DemoHelpDesk to open the DemoHelpDesk schema for
modification.

4. Click the Customer Satisfaction field to highlight this field.

5. From the Edit menu, select Delete.

6. Click Apply.

7. At the warning, click Continue to delete the field.

8. Click Dismiss to close the schema.

9. Minimize the Administrator Tool.
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10. Restore the demonstration environment by running demoRestore from
your <install_dir>/demo  directory.

Where to Go from Here
Now that you have successfully completed the AR System Help Desk
Demonstration, you can proceed to other tasks. Remedy provides some helpful
products to help you understand more about the processes you would like to
implement, as well as how to use the AR System to achieve these goals. This
section lists some suggested directions in which to proceed to get your help
desk completed.

Review the Sample Schemas Included with the AR System

The Action Request System provides a suite of sample schemas that you can
review to understand process definition and implementation. For more details,
see Chapter 4, Help Desk Demonstration and Sample Schemas.

Install the AR System Help Desk Templates

Your AR System package includes a CD with the AR System Help Desk
Template. This template contains a group of schemas that you can use for
internal help desk applications. The template includes sophisticated workflow
already defined to aid in problem definition and resolution, auto assignment of
tickets based on problem type, and the ability to access and modify the
solutions database from the HelpDesk schema. For more information on the
AR System Help Desk Template, see the accompanying Help Desk Templates
Guide for Users and Administrators.

Start Developing Your Own HelpDesk Application

If you feel comfortable in the process definition at your site, and in your ability
to create defined workflow with the AR System, you can start creating your
own schemas, active links, filters and escalations with the AR System
Administrator Tool. For more information regarding workflow definition and
implementation, see the Action Request System Administrator’s Guide.
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Help Desk Demonstration
and Sample Schemas 4

This chapter introduces the objects that comprise the Help Desk
demonstration. The Help Desk demonstration contains numerous schemas,
menus, filters, and active links. Although they provide for a good
demonstration environment, it is our recommendation that you do not use the
definitions included in the Help Desk demonstration as starting points for your
application. The Help Desk Templates, included in your AR System package,
are more suited for production development. For more information on the
Help Desk Templates, see the Help Desk Templates Guide for Users and
Administrators.

The chapter also provides a summary of the other sample schemas provided in
your AR System package. These samples provide some examples of other uses
for the AR System. The samples are good examples and good starting points,
but are not necessarily complete production environments.

Schemas in the Help Desk Demonstration
The demonstration uses a series of schemas that are based on the Help Desk
Templates. The demonstration schemas represent a scaled down version of the
Help Desk Templates. For more specifics regarding the schema designs and
associated workflow of the complete templates, see the Help Desk Templates
Guide for Users and Administrators.
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Schema Relationships

The diagram in Figure 4-1 shows the relationship of the schemas within the AR
System workflow demonstration. The DemoHelpDesk schema is the central
schema in the solution. Each of the other schemas contain information used by
the DemoHelpDesk schema.

Figure 4-1 Schema Relationships

DemoHelpDesk

The DemoHelpDesk schema is the primary interface to the demonstration
environment. You can access information by selecting buttons in the schema
that fire active links to the other, supporting schemas. The help desk staff

DemoHelpDesk The main Help Desk Demonstration schema

DemoHD:ProblemTypes and
DemoHD:ItemAffected

Used by dynamic menus to match proper values for the
ItemAffected field menu based on the value defined in the
Problem Type field.

DemoHD:CallerDetail Accessed directly by the help desk staff to add or edit
records in the caller database.

DemoHD:Solutions Used as a repository for proven solutions.

DemoHD:Staff Used by the Auto-Assignment feature to assign tickets to
the help desk staff.

DemoHD:ProblemTypes DemoHD:ItemAffected DemoHD:CallerDetail

DemoHD:StaffDemoHD:Solutions DemoHelpDesk
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members have access to the individual fields in this schema according to their
access control groups. In addition, different views of the DemoHelpDesk
schema have been provided for the users profiled in the demonstration.

Figure 4-2 below shows the End User view of the DemoHelpDesk schema for
Windows.

Figure 4-2 End User View of DemoHelpDesk Schema

An end user would use this schema to submit open issues to the support staff
for resolution. In the demonstration, Joe User submitted an entry when his web
browser, Web Wanderer, was not functioning properly. To make it easier for
end users to correctly fill in the fields, the administrator created an active link
which fills in the Last Name and First Name fields when the user presses
Return after filling in the Employee Id field. The active link queries the
DemoHD:CallerInfo schema for a match of the data in the Employee Id field,
then returns the data for the Last Name and First Name fields to the
DemoHelpDesk schema.

Francie Frontline used this schema (with a field organization different than
Joe’s view of the schema) to view Joe’s entry. Francie used the List My Open
Calls button to view a list of the tickets assigned to her. This button is an active
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link which queries all entries in the DemoHelpDesk schema with Francie
Frontline in the Assigned-to field and with a value in the Status field other
than Closed.

Figure 4-3 below shows the Frontline view of the DemoHelpDesk schema for
Windows.

Figure 4-3 Frontline View of DemoHelpDesk Schema

Bob Backline used this schema (with a schema view different from both Joe’s
and Francie’s) to view the call assigned to him, and enter the solution once he
had resolved the problem. Once Bob entered the solution in the Possible
Solutions field, end users with the same problem could use the schema to solve
the problem on their own.

Figure 4-4 below shows the Backline view of the DemoHelpDesk schema for
Windows.
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Figure 4-4 Backline View of DemoHelpDesk Schema

Queries to the database could be based on any of the items in the field menus,
or a combination of data in two or more fields. When Francie and Bob tried to
resolve Joe’s issue, they used this schema to query for solutions which match
Joe’s specific problem.

Several filters are included with this schema. When a new ticket is submitted, a
filter assigns the ticket, and a second filter sends a notification to the person to
whom the ticket is assigned. For example, if Francie Frontline was assigned a
ticket, she would receive a notification letting her know she is responsible for
resolving the problem. Whenever data is changed in the Work Log field, a filter
updates the new information with the name of the person who entered the
new data and the time the new data was entered.

The active links and filters were created by the AR System administrator to
make resolving open issues a simple and speedy process.
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DemoHD:CallerDetail

The DemoHD:CallerDetail schema contains a profile for each potential caller.
The profile data includes office number, location, department name, telephone
number, fax number, pager number and PIN, email address, notification
method, hotlist status, and separate logs for general customer and equipment
information. The help desk administrator populates this schema with an entry
for each known caller.

Figure 4-5 shows the Windows view of the DemoHD:CallerDetail schema.

Figure 4-5 DemoHD:CallerDetail Schema

The List Callers Open Calls button is an active link which connects with the
DemoHelpDesk schema to list all open calls for a specific person. In order for
the active link to function, one of the following fields must be filled: Employee
Id, Last Name, First Name, or Phone Number. For example, Francie Frontline
may wish to know how many of Joe User’s tickets have yet to be resolved. She
would enter Joe’s employee ID number and click List Callers Open Calls. If Joe
has any open calls, they will appear as a list. If she wanted the details of the
listed tickets, she would double-click one of the listed entries, and the ticket
would appear in Display mode.
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DemoHD:Staff

The DemoHD:Staff schema contains a profile for each member of the help desk
staff. The profile information includes whether the technician is currently
available to take calls, the technician’s current call load (available by clicking
List Open Calls), and particular skill area.

Figure 4-6 displays the DemoHD:Staff schema for Windows.

Figure 4-6 DemoHD:Staff Schema

The help desk administrator configures and maintains this data. Workflow
definitions for the DemoHelpDesk schema use the information in this schema
to automatically assign new calls to available backline technicians. The AR
System administrator achieves this through a filter.

In the demonstration, this schema is automatically queried, and the new ticket
is assigned. The workflow matches the Problem Type definition of Software to
Francie Frontline’s DemoHD:Staff entry, which defines her as Primary For
Software. Thus, the AR System automatically notifies her when a user submits
a software problem.
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DemoHD:ItemAffected

The help desk administrator populates the DemoHD:ItemAffected schema
with a list of secondary problem categories for each primary problem category
defined in the customizable DemoHD:ProblemTypes character menu. The
administrator of the demonstration environment, for example, used this
schema to submit four tickets with Software in the Problem Type field. For
each of these tickets, a different value was entered in the Item Affected field.
For this demonstration, the values are Excel, Other, Web Browser, and Word.

A Windows view of the DemoHD:ItemAffected schema is shown in Figure 4-7.

Figure 4-7 DemoHD:ItemAffected Schema

Each entry in the DemoHD:ItemAffected schema represents a problem
subcategory for the Problem Type field of the DemoHelpDesk schema. When
the user selects an entry in the Problem Type field of the DemoHelpDesk
schema, workflow definitions access the information in the
DemoHD:ItemAffected schema to dynamically populate the Item Affected field
with the list of problem subcategories associated with that Problem Type.
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The demonstration uses this schema to provide data for the query type
character menu that returns the software-specific selections in the Item
Affected field. So, when Joe User enters Software in the Problem Type field of
the DemoHelpDesk schema, the menu for the Item Affected field shows Excel,
Other, Web Browser, and Word.

DemoHD:ProblemTypes

The DemoHD:ProblemTypes schema is a database of problem summaries that
could apply to the combination of primary and secondary problem categories
defined in the DemoHD:ItemAffected schema.

Figure 4-8 shows the Windows view of the DemoHD:ProblemTypes schema.

Figure 4-8 DemoHD:ProblemTypes Schema

The system administrator could design workflow so that the information in the
DemoHD:ProblemTypes schema is used to populate the Problem Summary
field in the DemoHelpDesk schema. The administrator of the demonstration
environment could also design workflow that removes items from the Problem
Summary field of the DemoHelpDesk schema when the Status field of the
DemoHD:ProblemTypes schema is set to Obsolete.
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This workflow was not included in the demonstration.

DemoHD:Solutions

The HD:Solutions schema contains profiles of known problems and their
solutions. For each index of problem type, item affected, and problem
summary contained in the Demo HD:Solutions schema, one or more solution
profiles may be available. Each solution profile includes solution details and
the solution status. Frontline technicians in this sample environment can only
view current solutions.

A Windows view of the DemoHD:Solutions schema is shown in Figure 4-9.

Figure 4-9 DemoHD:Solutions Schema

In the Help Desk demonstration, you can see an example of the use of this
schema during Joe User’s attempt to find a logical solution to his problem.
When Joe clicks the menu icon of the Possible Solutions field in the
DemoHelpDesk schema, the menu queries the DemoHD:Solutions schema.
Only those solutions that match Joe’s particular criteria (according to the data
he enters in the fields of the DemoHelpDesk schema) are returned. The profile
data is indexed by problem type, item affected, and problem summary.
Alternatively, a keyword search can be used.
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AR System Sample Schemas
The following section gives an overview of the AR System sample schemas.
These schemas are provided as an example of some information you may want
to track using the AR System. These schemas are merely a sample
representation, and are not intended for production use. In some instances,
workflow has been designed to tie schemas together, but most are standalone.

This chapter provides information on the following sample schemas:

• AR-Contact Info

• AR-Job Requisitions

• AR-Recruiting

• AR-Lunch

• AR-Messages

• AR-Sales Leads

• AR-Bug Tracking

AR-Contact Info Schema

Figure 4-10 AR-Contact Info Schema



92 Action Request System Getting Started Guide and Sample Schemas—January 1996

4

The AR-Contact Info schema is designed to keep track of all business contacts.
If you like, you can think of this schema as a contact card file that you can
query at any time. The fields to be used most often might be Last Name and
Company Name, which, when used to query, would give the user all of the
information on the company or contact listed.

The Status field could be used to query for only current contacts, or only those
contacts no longer employed. A user could, for example, query for a list of all
current contacts at a particular company by marking the Status field Active,
and filling in the Company Name field with the company in question.

You could add active links to tie the information contained in the contact file
directly into other schemas in the AR System. For instance, you might create an
active link button on the AR-Messages schema which pulls data from the AR-
Contact Info schema.

The AR-Contact Info schema shows some of the capabilities of the AR System
to track and store data. In particular, this schema simulates a personal phone
book (with the addition of other information as you see fit, such as Status and
Contact Notes). The AR System also makes it possible for you to access this
information quickly and from several other schemas. You decide how the
system will work for your needs.
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AR-Job Requisitions Schema

Figure 4-11 AR-Job Requisitions Schema

The AR-Job Requisitions schema, along with the AR-Recruiting schema
described later, is designed to help streamline the new employee hiring
process. The AR-Job Requisitions schema keeps track of open positions within
a company.

When job requisitions are granted, a schema like this might be used to track
how many exist in each department and how many are unfilled. As
requisitions are filled, a schema like this allows you to track how many
positions are staffed and when they were filled.

A sample scenario could be managers requesting new hires. The manager
enters a ticket describing the position they wish to fill. The request is then
automatically sent to executive management and/or the Personnel department
for approval, and the hiring process begins. If the position should be filled
soon, the Status field might be set to OK to Hire.



94 Action Request System Getting Started Guide and Sample Schemas—January 1996

4

The Look up Candidates active link button ties this schema together with the
AR-Recruiting schema used to track individual job candidates for a particular
position. By clicking the Look up Candidates button, a user could view all of
the candidates listed in the AR-Recruiting schema according to the criteria set
in the AR-Job Requisitions schema.

AR-Recruiting Schema

Figure 4-12 AR-Recruiting Schema

The AR-Recruiting schema, along with the AR-Job Requisitions schema
described previously, is designed to help streamline the new employee hiring
process. The AR-Recruiting schema keeps track of all job candidates going
through the interviewing and hiring process.

The Status and Candidate fields are the primary fields on this schema. A user
might want to query for a list of all new candidates for a certain position. The
user may want an update on the status of a prospective employee.
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As the hiring process continues, the Interviewed by and the Comments fields
are of more interest. A manager may want to check on the status of an
interview, and could easily find this by querying this schema for the
candidate’s name. In a sample scenario, each person interviewing a candidate
is able to input feedback directly into the schema. They indicate what they
believe to be the relative strength of the candidate in the Vote field and can also
make an entry in the Comments diary field. The hiring manager is then able to
access all the relevant information about the candidate in one place, and make
a well-informed hiring decision.

The Look up Position button is an active link to the AR-Job Requisitions
schema. While a user is working on this schema, he may want to quickly check
the status of this position. Perhaps the position has been filled, or hiring has
been temporarily frozen. The active link provides a quick method of checking
information between schemas.

AR-Lunch Schema

Figure 4-13 AR-Lunch Schema

The AR-Lunch schema lets you inform everyone else in the organization that it
is time to eat and that you will be placing an order at a favorite restaurant.
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The lunch coordinator might change the value in the Status field to Request
Orders. This would fire a filter that notifies employees to open their views of
the AR-Lunch schema and place their orders.

Once notified, each person can call up the schema, fill out their request, and
submit their entry. End users might fill in the Item, Variety, Extras. Salsa,
Jalepeño, and Cheese fields by selecting items from the attached menus.

The administrator could have a filter set to fire a notification whenever a user
sets the How Hungry? field to Starvation Imminent. The lunch coordinator can
query for all the newly entered orders and order lunch. The lunch coordinator
might go so far as to have an escalation set to fire 20 minutes after the Status is
changed to Request Orders which would query the schema and fire a macro to
organize the results of the query.

Once lunch arrives, the lunch coordinator changes the Status field to Time to
Eat and all the hungry submitters can be notified via a filter.

This schema shows the flexibility of the AR System. A combination of filters,
active links, and escalations can ease an otherwise cumbersome process.

AR-Messages Schema

Figure 4-14 AR-Messages Schema
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The AR-Messages schema provides another simple but useful example of how
you can use the AR System to make your business processes run more
efficiently. This schema is simply an online telephone message pad that
automatically sends notifications to the party being called, via a filter, to let
them know that a message is waiting for them. The person answering the call
merely fills in the appropriate fields, and clicks Apply.

The person being called can then open the message directly from their
Notification Tool and respond. The person who takes the message never needs
to leave their desk and the person receiving the message never needs to worry
about a message getting lost.

Through a schema like AR-Messages, an end user is able to search for calls
according to specific criteria. For instance, an end user might want to check all
messages left by a specific person or by people from a specific company. If the
user did not want to delete tickets from the database, a schema like this would
track all messages, serving as an electronic record.
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AR-Sales Leads Schema

Figure 4-15 AR-Sales Leads Schema

This schema helps keep track of potential contacts that might result in sales of
your organization’s products. You can use the schema to record contacts and to
track each action that you take in the process of following a sales lead. This
schema is an example of how you can use the Action Request System to track
and log leads during a complete sales cycle.

The AR-Sales Leads schema contains information such as the contacts for a
lead, the actions to take next, and forecasting information. Queries can be
performed for any combination of fields on the schema, quickly providing any
needed information.

To submit a new entry, you might first enter the information on the primary
contact for the lead in the fields at the top of the screen. As new information
needs to be added over time, you could use the Modify Individual mode to
alter the ticket.
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You can use the Make New Contact active link button to create a secondary
entry for an alternate contact. This would draw information from some of the
fields, and automatically submit a new ticket with this information.

The List All Contacts active link button is a quick way to list all existing
contacts for a specific company. The system administrator set criteria for this
particular active link, so the user will only be able to fire it if a value is entered
in the Company field. While this may not suit your needs, it highlights the
adaptability of the AR System.

During the course of following up on a lead, a sales person can query the
database for any actions they need to perform using the Today’s Actions and
Next 7 Days’ Actions active link buttons. When fired, these active links open a
list on the screen describing the tasks related to the sales leads database.

When the actions are performed, the user enters the appropriate data in the
Action Type, Priority, Action Date, and Action Regarding fields, then clicks the
Action Done button. This button is an active link which pulls data from the
above listed fields, and logs an entry in the Action History diary field. Now,
when a user queries this ticket, he will be able to quickly see what has been
accomplished with this lead, and when it was accomplished.

A schema such as AR-Sales Leads would be used by several persons to query
and modify tickets. A schema like this is ideal for either a single sales person
or a sales team. Everyone with access to the schema would be able to see the
status of the lead, and would be able to act according to the latest information.
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AR-Bug Tracking Schema

Figure 4-16 AR-Bug Tracking Schema

The AR-Bug Tracking schema is designed for use during a product
development cycle to help various departments within an organization keep
track of defects and requests for product enhancements.

The design of the schema makes it possible for anyone to view open requests
and submit new problem reports. A submitter can then track the progress of
their own action request as it is acted on by the development team.

If, for example, Joe User has a problem with one of his software solutions, he
would use a schema like AR-Bug Tracking to enter the information in the
appropriate fields, set the value of the Status field to New, then submit the
ticket.

The system administrator can create a filter that automatically routes the
submitted ticket to the appropriate technician based on the data in some of the
fields, say the Product, GUI, DB, OS, or Problem Area.
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Once the development team has acted on the action request, either by fixing
the problem, if one exists, or describing the reasons why a request is being
deferred or denied, they change the value in the Status field, then notify
Quality Assurance (QA). A QA technician can verify that the action taken was
appropriate, and can then close the action request by changing the Status field
value to Closed. The system administrator can implement a filter that
automatically sends a notification to the person who submitted the bug,
alerting the submitter of the fix.

At any point during the development cycle, you may generate reports that can
be used as a gauge of the readiness of the product. For instance, you can make
a qualified query of the database. Set the Product and Version fields to the
appropriate values, set the Category field to Bug, and, in the query bar, set the
Status field to have a value less than Fixed. The above sample query would
return all New. Assigned, and Deferred bugs against a particular version of a
product.

You could then use the Report utility to have the query data returned in any
way you see fit. If you will make a query with the same qualifications many
times, you can make the process even easier through the use of a macro.

This schema represents an example of how the AR System can be used to not
only enable your staff to efficiently resolve product issues, but also to generate
reports which are up-to-the-minute accurate and easy to generate.
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Glossary

access control
Security feature that lets you limit the access users have to specific fields
within a schema and to specific functions within the system.
See also access control group, permissions.

access control group
Facility of the Action Request System used primarily to define user access to
the contents of a schema field. Each group can have its own member list
defining users who belong to that group. The AR System defines a number of
special groups: Public, Administrator, Subadministrator, Customize, Submitter,
Assignee, and Flashboards Administrator. You can define additional groups
through the Group schema. Once you have defined a group, you can specify
the type of access that the group will have to specific fields within a schema.
See also access control, permissions.

access permissions
See permissions.

action request
AR. A collection of information that describes an event (transaction), such as a
problem or a service request.

active link
A cause and effect relationship that you define on a per schema basis. Active
links cause the Action Request System to perform specific operations in
response to specific user actions. The AR System administrator can define
active links that run macros, set fields to specified values, run independent
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system processes, send an interactive message to the user, change field
characteristics, or execute a DDE operation on a Windows User Tool. Active
links run on the client machine.

administrator
Individual responsible for the management of the AR System, including setting
up schemas, setting access rights for users, and designing the workflow
process. To manage the AR System, you must be a member of the
Administrator or Subadministrator group.

administrator default
Value that the administrator assigns to a field while designing the schema.
When the user sets defaults, this value is used unless the user has assigned
their own default. When a user submits an AR, the AR System automatically
enters this value in the field unless the user has assigned their own default or
has entered a different value.

administrator command
Menu extension defined by the AR System administrator using the
Administrator Tool. Administrator commands allow users to invoke specific
commands running on the server. (Administrator commands are not available
from PC or Macintosh clients.) See also user command.

Administrator group
One of several special access control groups provided by the AR System.
Members of this group have full and unlimited access to the AR System,
including unlimited ability to create schemas, filters, escalations, active links,
menus, and administrator commands. See also Subadministrator group.

Administrator Tool
The part of the AR System used exclusively by administrators (and to a lesser
extent, by subadministrators) to set up the system for use by support staff and
end users. This includes setting up schemas, setting access permissions (users
and groups), and creating filters, escalations, active links, menus, and
administrator commands.

administrator view
The layout of a schema that was designed by the AR System administrator.
This is the view that users will see unless they customize their view.
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admin server
The arserverd process that can handle any AR System operation. The admin
server performs all admin restructuring operations, guaranteeing the
serialization and integrity of data. There can be only one admin server process
at any time.

API
Application program interface. A set of functions that provide application
programmers with access to the full functionality of a product. The AR System
API provides a complete interface to the AR System server.

AR
See action request.

arservtcd server
The controller server process that handles requests from clients for information
on which socket to use for communicating with other server processes.

AR System client
1. Subset of AR System software necessary to allow a user to access an AR
System server on the network and run the AR System tools on a local
workstation.
2.Hardware (workstation, terminal, Macintosh, or PC) running the AR System
client software.

AR System server
1.Full set of AR System software, including the arservtcd and the fast, list, and
escalation arserverd processes. When installed on a workstation on the
network, the server software provides access to the full feature set of the AR
System and can be accessed by workstations, Macintoshes, terminals and PCs
on the network that are running the AR System client software.
2.Hardware (workstation) running the AR System server software.

ARWeb license
Fixed or floating license that allows a user access to the ARWeb product.

assignee
The person who is assigned responsibility for resolving an action request.
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Assignee group
One of several special access control groups provided by the AR System. This
is an implicit group; users automatically belong to this group and, if they have
a valid AR System license, are granted change access for ARs for which they
have been assigned responsibility (their name is in the Assigned-to field).

broadcast operation
A distributed operation in which one source server simultaneously transfers
data-only copies of entries to two or more target servers.

chained operation
A distributed operation in which one source server transfers an entry to a
target server, and the target server in turn transfers the entry to another server.
This operation is used in environments containing three or more servers.

character data type
Data type used for fields where you will be entering text. The AR System
administrator can specify a maximum length for the field or leave the length
unlimited. The administrator can also specify a pattern to restrict the data that
users can enter or attach a character menu to the field.

character menu
A type of menu that the AR system administrator can create and attach to any
character-type data field. Character menus can be displayed as list boxes or
pull-right menus.

client
See AR System client.

command line options
Parameters that you can combine with the commands to start the User,
Administrator, Notification, and Import Tools that allow you to specify how
the tools will run. For the User Tool, you can execute a macro or open to the
Query or Submit window. For the Administrator Tool, you can attach to a
specific server or open the tool with a specific category displayed.

configuration
1.The process of setting up hardware and/or software so that it operates in a
manner consistent with the needs of a location.
2.The physical setup of a device or devices.
3.The operating characteristics of software.
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core field
One of a set of basic fields that are common to all AR System schemas.
Additional limits, such as fixed or maximum sizes, are placed on some core
fields.

Customize group
One of several special access control groups provided by the AR System. This
group grants users the right to customize their schema layout and create
custom commands in the User Tool.

database
A collection of information maintained in the form of individual entries.

data type
Property of a field that determines what type of information the field contains.
The choices are character, date/time, diary, integer, real, and selection.

date/time data type
Fields with this data type are limited to calendar dates and time.

DDE
Dynamic Data Exchange. This is a standard inter-application communication
feature used in Windows applications. For more information, see your
Windows documentation.

default
Administrator or user defined setting or value that automatically applies to a
field if users do not supply a different setting or value when submitting a new
action request.

default mapping
The mapping selected by the Distributed Server Option if the AR System finds
multiple mappings which apply to the specified transfer criteria.

diary data type
Fields with this data type allow you to capture a history of the actions taken
for an AR. Each multiple character entry is stamped with the time, date, and
name of the user who entered the item.

distributed delete
To remove an entry from the AR System. In a distributed environment, a copy
of an entry may be deleted on one server if the master copy is deleted on
another server.
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distributed fields
Fields you can add to an AR System schema which allow you to manipulate
certain mapping controls. The amount and type of fields added to a schema is
determined by the mapping type selected.

distributed processes
These processes control the action that is taken when filter or escalation criteria
is met within a given schema. There are three distributed processes you can
select as the Run Process action in a filter or escalation: Distributed-Transfer,
Distributed-Return, and Distributed-Delete.

distributed return
A distributed operation that returns the latest copy of an entry, with
ownership, to the requesting server.

distributed server
An AR System server that exists within a multi-server, distributed
environment.

distributed transfer
A distributed operation that sends a copy of an entry, with or without
ownership, from one server to another.

distributed update
A distributed operation that refreshes a copy of an entry on one server when
the master copy, on another server, is modified.

duplicate entry IDs
A condition that may occur in a distributed operation when an entry
transferred from the source server has the same entry ID as an entry on the
target server. The Distributed Server Option provides several options to handle
this issue.

dynamic menu
Menu that performs a query at the time a user selects the menu icon and uses
the results of the query to build the list of menu items from which the user
chooses.
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email
Electronic mail. The AR System allows you to set up an electronic mail handler
so that users can submit ARs through email if they do not have access to a User
Tool or if the AR server is inaccessible. (If you are running the client tools on a
PC, your PC must be equipped with an SMTP gateway to allow email
submissions.)

end user
In the AR System, an end user is the person who notifies support staff of
problems and service requests by submitting ARs.

escalations
Facility that tests server transactions at specified times or regular intervals to
see if certain conditions are met and responds to the conditions by taking a
specific action or actions. The AR System administrator can define escalations
to perform actions such as notify an individual, run a process, set specified
fields, or make an entry to a log file.

This facility is useful if, for example, you want to notify support staff when
ARs are in the Assigned state too long.

escalation server
The arserverd process that, if enabled, handles all escalation operations.

export
Facility that lets you move schemas, filters, active links, menus, administrator
commands, and mail templates to a file. Exporting is useful if you want to
share schemas, filters, active links, menus, and administrator commands with
another server or generate mail templates.

fast server
The arserverd process that, if enabled, handles the operations that generally
run to completion quickly without blocking access to the server.

extension
See user command, administrator command.

filter
Facility that tests every server transaction to see if certain conditions are met
and responds to the conditions by taking a specific action or actions. The AR
System administrator can define filters that set fields to specified values, run
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independent system processes, send an interactive message to the user, notify
the user when the state of an AR changes, or make an entry in an audit trail log
file. Filters run on the server.

fixed license
Write license that is permanently assigned to a user so that the user always has
access to the AR System.
See also floating license, write license.

Flashboards license
Fixed or floating license that allows a user access to the AR System
Flashboards product.

floating license
Write license that exists on a server and is allocated to any user who requests a
license and who is defined in the User database as having a floating license
type. If no floating license is available at the time of the user request, the user
must wait until a license becomes available.
See also fixed license, write license.

FTS
See full text search.

FTS license
Fixed or floating license that allows a user to perform a full text search in any
large text or diary field indexed for FTS.

Full Text Search (FTS)
Facility that allows a user to quickly search for information in large text or
diary fields. The fields must be indexed and FTS-enabled by the AR System
administrator, and the user must have an FTS license.

group access
See group type.

Group schema
Schema that lets you add new groups, delete groups, and modify group
permissions.

group type
The maximum permission type allowed for a group. May be None, View, or
Change. (Note that permission may be set below the group’s maximum at the
field level.)
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guest user
An unregistered user with a limited set of capabilities (submit ARs and
possibly review those ARs). Unregistered users may not be allowed at your
site.

hidden field
A field that exists but is not visible in a user’s view of the schema.

import
Facility that lets you share schemas, filters, escalations, active links, menus,
and administrator commands that were created on another server. First, you
must export the definitions from the server on which they were created to an
ASCII file, then you can import the file to your own server.

Import Tool
The part of the AR System that lets you transfer data from one server to
another.

integer data type
Fields with this data type contain numeric values between
-2147483648 and 2147483647. (The range for a particular field may be limited
by the administrator.)

license
See Flashboards license, fixed license, floating license, FTS license, read license,
write license.

list server
The arserverd process that, if enabled, handles the operations of the AR System
that may take some time to complete: AR Export, ARGetListEntry (high-
performance database searches), and ARGetEntryStatistics.

login window or dialog box
Window that allows you to login to the AR System when you first start an AR
System tool.

macro
A set of operations recorded for later execution. Macros are useful for
automating frequently used or complex query operations.
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mail template
Template that contains the fields that you need to fill in to submit an action
request using electronic mail. Templates are generated by the administrator
from existing schema using the export facility. (If you are running the client
tools on a PC, your PC must be equipped with an SMTP gateway to allow
email submissions.)

mapping
The parameters for a particular distributed operation, such as To and From
servers and schemas, data control issues, and field-to-field mapping
definitions.

mapping history
A history tracking record created when a distributed operation occurs. This
record includes the date and time of transfer, source entry ID, source schema,
source server, and the name of the specific mapping used.

master copy
The copy of a distributed entry which currently has ownership.

multiple schema views
Ability of an administrator to create different views of what users see when
they bring up a schema, including hiding or re-arranging fields by changing a
field’s display properties.

multi-process server
A product that allows the AR System administrator to distribute operations
among different servers and, consequently, improve the performance of the AR
System.

For example, the arservtcd process routes the load among the Admin server,
Fast server, List server, Escalation server and Private servers as appropriate,
automatically starts the specified arserverd processes and restarts the arserverd
processes if they terminate.

notification
An alert that tells you that an AR System event has occurred. The alert may be
a system beep, flash, the display of a notice window, or the opening of the
Notification Tool.

Notification Tool
The part of the AR System that alerts you when specific changes are made to
ARs. Also referred to as the Notifier.
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operator
One of a number of functions that let you define complex queries or build
qualifications. The AR System operators are available through use of the query
bar palette or the qualification palette or you can type them in directly.

pending operation
A distributed operation that is waiting to occur. Pending operations are
typically due to a specified transfer interval that has not yet been met, or
because there are network or server-related problems within the distributed
environment.

permissions
Property setting that allows you to control who can view and change
individual fields of a schema. You also set permissions for schemas and active
links. Permissions are defined for each access control group. View permission
limits group members to reading the contents of a field. Change permission
allows group members to read and write the contents of a field. See also access
control group.

pick list
See selection list.

private server
An arserverd process that, if enabled, provides dedicated access to system
operations for specific users.

property
An attribute that is defined. For example, the properties of a field include its
data type, physical characteristics such as length, and whether it is required or
optional.

Public group
One of several special access control groups provided by the AR System. Every
user is automatically a member of this view only group.

pull-right menu
See character menu.

query
Process that lets you select a subset of ARs according to search criteria that you
define and then perform one of several operations on the selected ARs. See also
query operation.
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query bar
 that lets you define complex query criteria. Includes a palette of operators that
you can use in the query you build.

query list
A list that includes a one-line summary of each AR matching a query.

query operation
Action that you can perform on the entries that match the criteria defined in a
query. The possible operations are: Query List, Display, Modify, Report, and
Delete.

query statement
A complete definition of query criteria constructed in the query bar.

Query window
The User Tool window that lets you search the database for ARs that match
specific criteria and display the results of the search. You also use the Query
window to view or modify an existing AR. See also Submit window.

range
Defines the upper and lower limits of acceptable values. For example, if a
field’s range is -10 to 100, you will be able to enter any number from negative
10 to positive 100 inclusive.

read license
License that allows a user to query the AR System schemas and submit new
ARs but does not allow the user to modify existing ARs. See also write license.

real data type
Fields with this data type contain a floating-point number. The range is set by
the administrator.

report format
The layout that you specify when you generate a report from an AR System
query. You can format a report in columns or as a list of records. You can also
choose selected fields to print or print them all. To create a more sophisticated
layout, you can export the report to a file and import the file into a desktop
publishing application.

reserved field
One of a set of fields defined with specific interpretations. You can use these
fields in any schema, if desired.
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return mapping
The specific field-to-field mappings used when an entry is returned.

row level access control
The ability to control a user’s access to particular rows, or parts of rows, within
AR System database tables.

schema
The definition of the data fields in a database. Each schema represents a
database on an AR System server. The AR System comes with several sample
schemas and you can build as many additional schemas as needed.

scroll bar
Window element that appears when there is more information to view than
will fit in the window. You use the mouse to slide the scroll bar and shift the
view area. A scroll bar at the bottom of the window lets you move the viewing
area left and right. A scroll bar on the right side of the window lets you move
the viewing area up and down.

selection data type
Fields with this data type present a set of mutually exclusive choices from
which the user is to choose. The selections are displayed as radio buttons or as
items on a menu.

selection list
List that appears as a result of an active link that performs a query that returns
more than one AR. The selection list lets the user pick the appropriate AR so
the active link can continue processing.

server
See AR System server.

status field
Core field that lets you keep a record as an AR moves through the various
stages of the process you are using to resolve ARs. The defined states should
reflect the workflow process.

status history
Information that shows the progress that has been made on an AR. You can
view status history from the Display or Modify Individual window.
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subadministrator
Individuals who have limited administrative access to the AR System. To be a
subadministrator, you must be a member of the Subadministrator group and
belong to a group with subadministrator access to a schema.

Subadministrator Group
One of several special access control groups provided by the AR System.
Members of this group have limited access to the AR System. You must be a
member of this group to be able to administer any schemas that your group
has subadministrator access to and to create and administer filters, active links,
and escalations connected to schemas that your group has administrative
access to.

Submit window
The User Tool window that lets you enter the appropriate information to create
and submit a new AR. See also Query window.

submitter
The person who submits an action request. The submitter’s name is entered in
the Submitter field.

Submitter group
One of several special access control groups provided by the AR System. This
is an implicit group; users submitting ARs automatically belong to this group
and, if they have a valid AR System license or if the Submitter Mode is set to
Locked, are granted change access for ARs that are submitted with their name
in the Submitter field.

support staff
Person or group responsible for resolving action requests. They assign and are
assigned ARs, log their progress in appropriate fields, and use information
stored in previous ARs to help resolve problems.

toolbar
that allows easy access to some of the more commonly performed functions in
the Windows Administrator Tool: New Server Window, New Object, Save,
Align Left, Align Right, Align Value Left, Align Value Right, Align Top, Align
Bottom, and Show Grid.

transfer
A distributed operation that sends a copy of an entry, with or without
ownership, from one server to another.
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transfer mapping
The specific field-to-field mappings used when an entry is sent from one server
to another.

user default
Value that a user who has customize permission can assign to a field. When the
user sets defaults, the AR System loads this value into the field. When the user
submits an AR, the AR System automatically loads this value into the field
unless the user has entered a different value.

user command
Facility that allows you to invoke an operating system command (or
application capable of being run from an operating system command line)
from the Execute menu of the Query window. Each user can define their own
set of user commands. (User commands are not available from PC or
Macintosh clients.) See also administrator command.

User schema
Schema that lets you add users to the AR System and specify the type of access
each user will have.

User Tool
The part of the AR System that lets users enter new ARs and track them
through the troubleshooting process. Users can also query the database for
ARs that match specified criteria, generate reports, and modify existing ARs
with the User Tool.

user view
What the user sees when they bring up a schema. If users have permission to
customize their views, they are able to change the physical layout and other
properties of the schema and schema fields as they appear.

variable
Data element that changes according to user input. In macros, you can include
variable definitions that will cause the AR System to prompt the user for
certain information when the macro executes.

version
The system release number. To display the version of the AR System that you
are running, select About under the Help menu in the User, Administrator, or
Import Tools.
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view layout
The location of fields in a user’s view of a schema.

wild card
Character that you can enter to represent other characters in a query. In query
statements in character and diary fields, for example, you can use wild card
characters to match single characters, strings, or characters within a range or
set.

write license
License that allows a user to modify and save data on existing ARs as field and
schema permission settings allow. Write licenses may be either fixed
(permanently attached to a single user) or floating (allocated to users as
required).
See also fixed license, floating license, read license.
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Notification Tool, 29, 67

customizing, 30
using to review tickets, 35, 71

Q
query menu, 16, 17, 55, 56
query window, 22, 53
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S
schemas, 2

AR-Bug Tracking, 100
AR-Contact info, 92
AR-Job Requisitions, 93
AR-Lunch, 95
AR-Messages, 97
AR-Recruiting, 94
AR-Sales Leads, 98
DemoHD:CallerDetail, 15, 54, 86
DemoHD:ItemAffected, 16, 55, 88
DemoHD:ProblemTypes, 89
DemoHD:Solutions, 17, 56, 90
DemoHD:Staff, 87
DemoHelpDesk, 12, 51, 82
modifications, saving, 42, 76
modifying, 37, 72
opening

as end user, 13, 51
as frontline technician, 22, 59

relationships, 82
selecting, 21

submit window, 14, 53

T
tickets

closing, 34, 69
information, entering, 15, 54
investigating

as backline technician, 32, 67
as frontline technician, 23, 24, 61,

62
reassigning, 26, 64
resolving, 33, 69
reviewing, 35, 71
submitting, 18, 57

U
User Tool, 12, 51
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